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Section 1
Getting Started
By the end of this section you should be able to:
Understand Basic E-mail Principles
Start and Close Outlook
Recognise and Use the Outlook Screen
Find Help

Work through the Driving Lessons in this section to gain an understanding of
the above features.
For each Driving Lesson, read all of the Park and Read instructions and then,
if applicable, perform the numbered steps of the Manoeuvres. Complete the
Revision exercise(s) at the end of the section to test your knowledge.
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Driving Lesson 1 - E-mail and Outlook
Park and Read
One of the most popular uses of the Internet is sending and receiving
“electronic mail” (e-mail). E-mail is an extremely important communication tool
that allows people to send multimedia messages to other ICT users anywhere
in the world instantly. Think about how much more quickly information can be
sent using e-mail rather than by traditional surface or airmail.
This guide will introduce you to Microsoft Outlook, a popular Personal
Information Management (PIM) tool that allows you to send, receive and
organise e-mail messages. Outlook can also be used to attach files to
messages, maintain an address book of contacts, and create useful calendars
and to-do lists.
There are many online services that you can use to send and receive
e-mail. However, in most professional situations, a Personal Information
Management tool such as Outlook is used.
Before you can use Outlook (or any other e-mail program or service), you will
first need your own e-mail address. In the same way that a phone number
uniquely identifies an individual telephone on a network, your e-mail address
uniquely identifies your “mailbox” on the Internet (i.e. the location where all of
your e-mail is delivered).
E-mail addresses all follow the same general format, as the following example
shows:
trainer@bigplanetsupport.co.uk
The @ symbol is pronounced “at” and is used to separate a person’s mailbox
name (which can include full stops, e.g. john.smith) from the domain name of
their organisation or Internet Service Provider (ISP).
If you do not know your own e-mail address, contact the person who runs your
computer network. If you are a home user, contact your ISP.
When you are not using Outlook, messages are stored for you until they are
collected. You do not need to keep the program running all of the time.

Manoeuvres
1.

Food for thought: there are approximately 3.3 billion e-mail users in the
world. In 2012, they sent around 144 billion e-mails every day!

2.

Do you know what your own e-mail address is? If you don’t know it, ask
the company or service that provides your e-mail.

© CiA Training Ltd 2016
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Driving Lesson 2 - Starting Outlook
Park and Read
Microsoft Outlook is an e-mail program that is part of the Microsoft Office suite
of applications. Although there are numerous ways to start the program, the
following method is recommended for beginners.
The steps required to start Outlook vary slightly depending on the version of
Windows installed on your computer.

Manoeuvres
1.

Start your computer and log in to Windows.

2.

Find and click the Start button,
or
left corner of the Desktop on the Taskbar.

3.

The Start Menu appears. Click All Programs or All apps at the bottom of
the Start Menu to show a list of available programs.

, found towards the bottom

If you are using Windows 8, a full Start Screen may be shown instead.
All Programs will appear as a downwards facing arrow.
4.

Find and click the entry for the e-mail program Outlook 2016. You may
need to scroll to find it.

You can also type Outlook when the Start Menu is open to search for and
start the program. You may also find a button for it on the Taskbar.
5.

Outlook starts. When the program appears on screen, move on to the
next lesson.

Outlook may need to be configured before it can be used for the first time.
Configuring is the term used to describe the supply of initial user information to
the program. If the Internet Connection Wizard or Add New Account dialog
box appears when you start Outlook, contact your IT Administrator or Internet
Service Provider who will be able to help you configure the program.
When you start Outlook you may first be asked to connect to the Internet – you
need to do this to send and receive e-mail. Also, if there is more than one
e-mail account (profile) available on the computer, you will need to select one.

Outlook 2016
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Driving Lesson 3 - The Outlook Window
Park and Read
When the Outlook window appears, the program will display your Mail view. All
of your e-mail messages are contained here in folders known as your mailbox.

Manoeuvres
1.

Examine the Outlook window and locate the Ribbon, Tabs, Folder Pane,
View Buttons, Message List, Reading Pane and Status Bar.
Title Bar
Tabs

Ribbon

Folder
Pane

View
Buttons

Message
List

Reading
Pane

Status
Bar

Don’t worry if your screen does not appear exactly as shown above. Outlook
features a wide variety of layouts and set-up options. You will learn how to
adjust basic display settings in the next lesson.
2.

Notice that Mail,
, is the currently selected view button at the bottom
of the Folder Pane. If it is not, click it once to select it now.

3.

Locate the Message List. This shows all of the messages currently
contained in the selected folder on the Folder Pane (e.g. Inbox). If this is
the first time you have used Outlook, the list will probably be empty.

4.

Locate the Reading Pane. The content of any message selected in the
Message List is previewed in the Reading Pane.

You can adjust pane sizes by dragging the boundary bar between them.
© CiA Training Ltd 2016
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Driving Lesson 3 - Continued
5.

Locate the Ribbon. This consists of a range of tabs containing buttons
organised into groups.
Tabs

Button

Group name

6.

The buttons on the Ribbon are used to select an action or command in
Outlook. Move the mouse pointer over any button but do not click. Read
the ToolTip that appears which gives the name of that button and a small
description.

7.

Click each tab in turn and examine the various features available. When
you are finished, return to the Home tab.

The File tab contains a list of basic program functions such as Info,
Save As, Print, Options and Exit. To close the File tab screen, click
the Back button in the top left corner (or press <Esc>).
8.

At the top left of the screen is the Quick Access Toolbar,
.
Identify the two useful buttons that are available here: Send/Receive All
Folders and Undo.

9.

Find the Status Bar which runs along the bottom of the Outlook window.
This displays messages as tasks are performed. Amongst other things, it
will currently show the total number of messages (or items) in your Inbox.

10. Notice the Zoom slider to the right side of the Status Bar. This can be
used to increase or decrease zoom levels in the Reading Pane.

By default, the Zoom level is set to 100%. However, if you find it difficult to read
text in the Reading Pane, feel free to “zoom in” at any time.
11. Leave the Outlook window open for the next lesson.
Outlook 2016
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Driving Lesson 4 - Outlook Views
Park and Read
There are many different views available in Outlook, but perhaps the most
important is your Mail view.
To match the screenshots shown in this guide, it is recommended that you set
up Outlook using the following instructions.

Manoeuvres
1.

Use the Maximise button, , on the right of the Title Bar to maximise the
Outlook window. Then, display the View tab on the Ribbon.

2.

In the Layout group, click the Folder Pane drop-down button. From the
options that appear, select Off and observe the effect. The Folder Pane
is hidden.

3.

Click the Folder Pane drop-down button again and select Normal.

4.

Next, click the Reading Pane button in the Layout group. Select the Off
option and observe the effect. The Reading Pane is hidden.

5.

Click the Reading Pane button again and select the Bottom option.

6.

To adjust your screen’s Mail layout to match this guide’s recommended
settings, click the To-Do Bar button and select Off. Then click the
Change View button and select Single (if available).

Your screen layout should now match the example shown below. You will learn
more about the To-Do Bar in a later lesson.

Message
List
Folders List

Reading
Pane
Folder Pane

View Buttons
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Driving Lesson 4 - Continued
7.

Examine the Folders List which contains a list of mailbox folders (Inbox,
Drafts, Sent Items, Junk E-mail, Outbox, etc). You will explore these in
more detail as you progress through this guide.

If you are using a web-based e-mail provider, your folders may appear grouped
under the service’s name (e.g.
). If this is the case, simply expand
this folder to view your entire mailbox.
8.

If your Inbox folder is not currently selected, click it once now.

All messages that you receive are placed in your Inbox folder. A number after
the folder name indicates how many unread messages are present.
9.

Next, to hide the Ribbon, click the Ribbon Display Options button,
shown at the top-right of the Outlook window (on the Title Bar).

,

10. Examine the options available and then select Show Tabs. Only the
Ribbon’s tabs are now shown – this gives you a little more room to work
in.

Clicking a tab will briefly display the full Ribbon again.
11. To restore the Ribbon to its original size permanently, click the Ribbon
Display Options button again and select Show Tabs and Commands.
12. Next, click the People view button,
, found towards the bottom of the
Folder Pane. This view can be used to access and organise your
“contact” information – details about friends, family, colleagues and
business contacts.
It is likely that there is no contact information shown here at the moment. Later
exercises will show you how to create new contacts.
13. Next, click the Calendar view button,
, on the Folder Pane. This view
can be used to plan your daily activities and schedule appointments and
meetings with other people.
14. Finally, click the Mail view button,
Outlook 2016
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Section 2
Send & Receive
By the end of this section you should be able to:
Compose a New E-mail Message
Address an E-mail
Send an E-mail
Receive an E-mail
Mark an E-mail as Read/Unread

Work through the Driving Lessons in this section to gain an understanding of
the above features.
For each Driving Lesson, read all of the Park and Read instructions and then,
if applicable, perform the numbered steps of the Manoeuvres. Complete the
Revision exercise(s) at the end of the section to test your knowledge.

© CiA Training Ltd 2016

18

Outlook 2016

ECDL

Section 2 Send & Receive

Driving Lesson 8 - Creating a Message
Park and Read
Using e-mail to send information is an extremely efficient way to communicate
with other people. All you need is the e-mail address of the recipient (the
person you are sending the message to).
Always be careful when you enter an e-mail address. One letter out of place will
result in the message being returned “undelivered” or – even worse – going to
the wrong person.

Manoeuvres
1.

Start Outlook. When the Outlook window opens, the Mail view should
appear automatically with the Inbox folder selected.

2.

Locate the New group on the Ribbon (make sure the Home tab
is displayed). Click the New Email button to start a new message.

3.

An Untitled Message window appears.

To box
Subject box

Message
Area

To give you more space to work in, you can maximise the Untitled Message
window (i.e. make it fill your entire screen) by clicking the Maximise button, ,
on the right of the window’s Title Bar.
4.

Maximise the new message window now (if it is not already).

5.

Notice that the cursor is currently flashing in the To box (if it is not, click
inside the To box now). The To box is where you enter the e-mail address
of the person you are sending the message to.

Outlook 2016
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Driving Lesson 8 - Continued
Entering your own e-mail address in the To box will cause any message you
send to be immediately returned to you. This allows you to observe the results
of sending messages. Sending a message to another person follows exactly
the same steps.
6.

Type your own e-mail address into the To box.

When instructed to enter your own e-mail address, enter the address of the
mail account that you are currently using with Outlook. If you don’t know it, ask
the company or service that provides your e-mail.
7.

Click once in the Subject box. The text you enter here is used to briefly
describe the content of your e-mail (allowing the recipient to see at a
glance what the message is all about).

It is good practice to always enter a short but relevant subject for every new
message that you create.
8.

Enter the following subject text: My First ECDL Message.

The e-mail address trainer@bigplanetsupport.co.uk will be used in
screenshots throughout this guide. Wherever relevant, you will be prompted to
substitute this with your own e-mail address.
9.

Click once in the Message Area. Notice that the title of the e-mail, shown
on the Title Bar, now changes to My First ECDL Message.

10. Type the following text into the Message Area:
I am sending this e-mail message as part of my studies for ECDL.
If you make a spelling mistake when typing it will be underlined in red. You will
learn more about correcting spelling errors in the next section.

11. Leave the new e-mail message open for the next lesson.
© CiA Training Ltd 2016
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Driving Lesson 9 - Sending a Message
Park and Read
When you have finished composing (writing) a new e-mail, the message is
ready to be sent. Copies of sent messages are stored in your mailbox’s Sent
Items folder for you to refer back to later.
Depending on how Outlook is set up, the Sent Items folder may appear with a
slightly different name (e.g. Sent Mail). If this is the case, you will need to use
that folder in place of Sent Items.

Manoeuvres
1.

The e-mail created in the previous lesson (My First ECDL Message)
should still be open. You are now going to send it.

It is always a good idea to check the content of e-mail messages before you
send them to ensure address, subject and message text are all correct. Once
an e-mail is sent, there is very little you can do to get it back again.
2.

Click the Send button to send the message to the recipient (yourself in
this case).
Send Button

If you receive a prompt to correct spelling errors in your message, click Cancel.
Checking e-mail for spelling errors is covered in a later lesson.
3.

The e-mail window closes and the message is sent to your Outbox.

E-mail messages that you send are first moved to your Outbox folder before
being sent. If you are connected to the Internet, they will be sent immediately
from there. If you are not, messages will remain in your Outbox – this way you
can create e-mail messages “offline” and then send them all in one go when
you do connect.
4.

Select the Outbox folder,
, from the Folders List. Any
messages waiting to be sent are shown here.

If your Outbox is empty (and no number is shown in square brackets after the
folder name on the Folders List), then your message has already been sent.
Outlook 2016
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Driving Lesson 9 - Continued
The Send/Receive All Folders button can be used to force Outlook to send
any waiting messages (if this does not occur automatically).
5.

Display the Send / Receive tab on the Ribbon.

6.

Then, click the Send/Receive All Folders button. A
progress dialog box, similar to the one shown below, may
appear for a moment. If you are prompted to connect to the
Internet, please do so.

As it is used frequently, a Send/Receive All Folders button is also available on
the Quick Access Toolbar, . You can also use the keyboard shortcut <F9>.

A Send/Receive status message may be shown on the Status Bar. Always
wait for the Send/Receive process to finish before moving on.
7.

Select the Sent Items folder on the Folders List. Notice that a copy of
your message is saved here.

8.

If it is not already selected, click the My First ECDL Message item on the
Message List. A preview of the message’s content appears in the
Reading Pane.

9.

Leave Outlook open for next lesson.
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Driving Lesson 10 - Receiving a Message
Park and Read
When you receive an e-mail it is downloaded and stored in your Inbox folder.
New and unread messages are shown in the Message List in bold, blue type.
Once you read the message, its text changes to regular, black type.
E-mail messages are stored on a mail server (either in your company or at your
ISP) which is where they will remain until you download them. You do not need
to keep Outlook running all of the time.

Manoeuvres
1.

Select your Inbox folder,
, from the Folders List. The folder’s
contents are shown in the Message List.

2.

You will receive the message that you sent to your own address in the
previous lesson. If it has not appeared in your Inbox yet, use the
Send/Receive All Folders button to check for new messages.

Outlook will regularly check for new messages automatically, but clicking the
Send/Receive All Folders button forces it to check for new messages
immediately. Bear in mind that it sometimes takes a little while for messages to
“pass through the system”.
3.

The name on the message indicates who the e-mail was sent FROM,
followed by the SUBJECT and date/time RECEIVED. A short, single line
preview of the message’s content will also appear.

It is possible that Outlook will identify your message as Junk Mail and store it
in a special Junk E-mail folder (if present). If so, open the Junk E-mail folder
from the Folders List on the Folder Pane and select the My First ECDL
Message e-mail. Display the Home tab on the Ribbon and click the Junk
button in the Delete group. From the submenu that appears, select Not Junk.
The message will be moved back to the Inbox.
Notice the All and Unread filter buttons above the Message List. All shows all
messages in your Inbox; Unread shows only unread messages. Throughout
this guide it is assumed that All is always selected.
Outlook 2016
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Driving Lesson 10 - Continued
4.

Click the My First ECDL Message e-mail once on the Message List, if it
is not already selected, to preview its contents in the Reading Pane.

5.

Double click the My First ECDL Message e-mail on the Message List to
open it in a new window. Notice the features available on the Ribbon.

6.

Close the e-mail by clicking the Close button,
right corner of the message window.

7.

Notice the My First ECDL Message e-mail on the Message List. As the
message is now considered to have been read (as you have opened it), it
will appear with regular black type.

, found towards the top

Sometimes you will open an e-mail but not have time to read it. Being able to
mark items as Unread so that you can return to and read them later is a very
useful feature.
8.

To mark the My First ECDL Message e-mail as Unread, first make sure
the Home tab is displayed.

9.

Then, click the Unread/Read button in the Tags group. The text reverts to
bold, blue formatting. As you have already seen, this is how all unread
e-mail messages are formatted.

Similarly, you can use the Unread/Read button to mark an unread message as
read.
Notice the number shown in brackets after the Inbox folder name on the
Folders List; this indicates the number of unread messages in that folder.
10. Click the Unread/Read button again to mark the message as read again.
11. Close Outlook.
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Driving Lesson 11 - Revision
Park and Read
At the end of every section you get the chance to complete one or more
revision exercises to develop your skills and prepare you for your ECDL
certification test. You should aim to complete the following steps without
referring back to the previous lessons.

Manoeuvres
1.

Open Outlook.

2.

Create a new e-mail message with the subject: Developing My Skills.

3.

Enter your own e-mail address in the To box.

4.

In the Message Area type:
I must remember to check my e-mail regularly!

5.

Send the message.

6.

Check your Outbox to make sure that the new e-mail has been sent (use
the Send/Receive All Folders button if necessary on the Send / Receive
tab).

7.

View your Sent Items folder to check that a copy of the message has
been saved.

8.

Return to your Inbox and wait for the Developing My Skills e-mail to
appear in the Message List, if it has not already (use the Send/Receive
All Folders button to check for new messages if needed).

9.

Select the new message in the Message List to preview it in the Reading
Pane.

10. Double-click the message in the Message List to open it in a new
window.
11. Close the Developing My Skills message window.
12. Mark the Developing My Skills message as Unread.
13. Mark the Developing My Skills message as Read again.
14. Close Outlook
Now complete the Record of Achievement Matrix at the back of the guide.
You should only move on when confident with the topics and features
described in this section.
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Driving Lesson 34 - Revision
Park and Read
At the end of every section you get the chance to complete one or more
revision exercises to develop your skills and prepare you for your ECDL
certification test. You should aim to complete the following steps without
referring back to the previous lessons.

Manoeuvres
1.

Create a new, informal signature for yourself named Personal.

2.

Create a new, self-addressed e-mail message. Notice that the Personal
signature text appears automatically.

3.

Enter the subject as Holiday.

4.

Type the following incomplete message into the Message Area:
Hi,
I’ve just heard that you are going on holiday to Colorado and will
be visiting the Grand Canyon. Here’s something that may
interest you:

5.

Press <Enter> to create a new paragraph.

6.

Open your Documents and navigate to the data files folder for this guide.

7.

Locate and open the document Colorado.

8.

Ignore the spelling errors and copy all of the document’s text.

9.

Close the program that opened Colorado and then close the Documents
window.

10. Paste the copied text into the Holiday e-mail on the blank line at the
bottom of the Message Area.
11. Correct the spelling in this message.
12. Delete the Personal signature.
13. Send the message.
Now complete the Record of Achievement Matrix at the back of the guide.
You should only move on when confident with the topics and features
described in this section.
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Section 8
Contacts
By the end of this section you should be able to:
Use Outlook’s People Feature
Add and Remove Contacts
Maintain and Edit Contacts
Create a Contact Group
Send Messages to Contacts
Delete Contacts

Work through the Driving Lessons in this section to gain an understanding of
the above features.
For each Driving Lesson, read all of the Park and Read instructions and then,
if applicable, perform the numbered steps of the Manoeuvres. Complete the
Revision exercise(s) at the end of the section to test your knowledge.

© CiA Training Ltd 2016

64

Outlook 2016

ECDL

Section 8 Contacts

Driving Lesson 35 - People View
Park and Read
Over time you will find that many of the e-mail messages that you create will be
sent to the same group of people (your “contacts”). Often, these will be friends,
family or work colleagues. To avoid having to remember their e-mail addresses
and contact details, you can store them as Contacts in Outlook’s People view.

Manoeuvres
1.

From the bottom of the Outlook Folder Pane, click the People view
button.

2.

Take a look at the People view that appears.

Current
View

Contact
List

Letter
Tabs

If you have never used People view before, it is likely that the Contact List
shown will be empty. In the next exercise you will create new contacts.
3.

Notice the contact display options in the Current View group on the
Ribbon. These allow you to display your contact information in various
ways (People is selected in the above example).

The Letter Tabs displayed vertically down the left side of the Contact List can
help speed up the finding of a contact. Simply click the letter tab that matches
your contact’s first or second initial.
Outlook 2016
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Driving Lesson 36 - Adding Contacts
Park and Read
New Contacts can be added to the People view by completing a simple form.
The information stored can include general details such as name, job title,
company name, address, e-mail address, and various phone numbers.

Manoeuvres
1.

Your People view should be open from the previous exercise.

2.

To create a new contact, click the New Contact button in the
New group on the Home tab.

3.

An Untitled Contact window appears. Enter your own personal details
into the text boxes (you do not need to complete every box). Make sure
you enter your real e-mail address correctly, however, as this will be used
in later lessons.

You can use <Tab> and <Shift + Tab> to move between text boxes.
If any dialog boxes appear (e.g. prompts to check full name or conversion of
telephone numbers), click Cancel to continue.
4.

After all of the information has been entered, click the Save &
Close button in the Actions group. A personalised contact has
now been created for you.

Make sure People is selected in the Current View group on the Ribbon.
5.

Let’s try adding a few more contacts. Click the New Contact button again
and enter the details shown on the following page.
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Driving Lesson 36 - Continued
Full Name:
Company:
Job title:
E-mail:
Business (phone):

Fiona Jones
Big Planet Support
Reception Assistant
fiona@bigplanetsupport.co.uk
0770 0900 823

Always make sure you enter details accurately, especially e-mail addresses
and phone numbers. Personal details such as date of birth, nickname or
anniversary can also be included by selecting Details in the Show group.
6.

Click Save & Close. The new contact is created and added to your
Contact List.

7.

Add the following friend as a new contact:
Full Name:
Company:
Job title:
E-mail:
Business (phone):
Mobile (phone):

Hassan Khan
Big Planet Support
Custom Contact Officer
hassan@bigplanetsupport.co.uk
0770 0900 472
0770 0900 526

8.

Save the new contact. The 3 contacts created in this lesson now appear
in the Contact List.

9.

Examine the new contacts created by selecting them in the Contact List.
Their details are shown in the Reading Pane.

Edit
Contact
View
Source

Notice the Edit contact button and View Source link in the Reading Pane. You
will use these in the next lesson to edit a contact’s details.
10. Leave the People view open for the next lesson.
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Driving Lesson 37 - Editing Contacts
Park and Read
Outlook makes it easy to change a contact’s details.

Manoeuvres
1.

People view should still be open from the previous lesson. Locate and
single-click the entry for Fiona Jones in the Contact List.

2.

You have been informed that she has been promoted to Reception
Manager and her work telephone number has changed to 0770 0900 583.
Let’s edit her contact record…

3.

Click the Edit button,

4.

You can now edit Fiona’s contact details. Change her job title to
Reception Manager and her Business phone number to 0770 0900 583.

5.

Click Save to update the contact’s details. Notice that Fiona’s information
in the Reading Pane has changed.

, found to the right of the Reading Pane.

You can also double click an entry in the Contact List to edit details in a new
window. If you do this, you will need to close the edit window after saving.
6.

Hassan Khan has transferred to another department. His new job title is IT
Support Executive and his Work phone number is 0770 0900 643.
Change his contact record accordingly.

To add new information to a contact, click the link below View Source instead.
© CiA Training Ltd 2016

68

Outlook 2016

